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IMPORTANT SAFETY PRECAUTIONS

COVER (OR BACK). NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING
TO QUALIFIED SERVICE PERSONNEL.

RISK OF ELECTRIC SHOCK
DO NOT OPEN

a ﬂ CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE

to alert the user to the presence of uninsulated “dangerous voltage” within the
product’s enclosure that may be of sufficient magnitude to constitute a risk of
electric shock to persons.

a The lightning flash with arrowhead symbol, within equilateral triangle, is intended

The exclamation point within an equilateral triangle is intended to alert the user to
the presence of important operating and maintenance (servicing) instructions in
the literature accompanying the appliance.

logated o ihe rear panch Ploase rocord WARNING: TO PREVENT FIRE OR
%A';%d?;l?;?ﬁ'tg”;:s‘f%?;:u“f’re%%?s;”“’“ber SHOCK HAZARD, DO NOT EXPOSE THIS
oce e APPLIANCE TO RAIN OR MOISTURE.

Serial number

— For U.S.A.
For the customers in Europe
TO THE USER
WARNING
This equipment has been tested and found to This is a Class A product. In a domestic
comply with the limits for a Class A digital device, environment, this product may cause radio
pursuant to Part 15 of the FCC Rules. These limits interference in which case the user may be required
are designed to provide reasonable protection to take adequate measures.
against harmful interference when the equipment
is operated in a commercial environment. This Pour les utilisateurs en Europe
equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in AVERTISSEMENT
accordance with the instruction manual, may cause Il s'agit d'un produit de Classe A. Dans un
harmful interference to radio communications. environnement domestique, cet appareil peut
Operation of this equipment in a residential area is provoquer des interférences radio, dans ce cas
likely to cause harmful interference in which case the I'utilisatgl’Jr peut étre amené a prendre des mesures
user will be required to correct the interference at his appropriees.
own expense.
Fiir Kunden in Europa
CAUTION Warnung
Changes or modifications to this equipment not Dies ist eine Einrichtung, welche die Funk-Entstérung
expressly approved by TEAC CORPORATION nach Klasse A besitzt. Diese Einrichtung kann im
for compliance could void the user's authority to Wohnbereich Funkstérungen versursachen; in
operate this equipment. diesem Fall kann vom Betrieber verlang werden,
angemessene MaBnahmen durchzuflihren und dafir
aufzukommen.

CE Marking Information

a) Applicable electromagnetic environment: E4
b) Peak inrush current: 8.0 A

In North America use only on 120V supply.
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IMPORTANT SAFETY INSTRUCTIONS

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this apparatus near water.
Clean only with dry cloth.

Do not block any ventilation openings. Install in
accordance with the manufacturer's instructions.

Do not install near any heat sources such as
radiators, heat registers, stoves, or other apparatus
(including amplifiers) that produce heat.

Do not defeat the safety purpose of the polarized
or grounding-type plug. A polarized plug has two
blades with one wider than the other. A grounding
type plug has two blades and a third grounding
prong. The wide blade or the third prong are
provided for your safety. If the provided plug does
not fit into your outlet, consult an electrician for
replacement of the obsolete outlet.

Protect the power cord from being walked on
or pinched particularly at plugs, convenience
receptacles, and the point where they exit from the
apparatus.

Only use attachments/accessories specified by the
manufacturer.

Use only with the cart, stand, tripod, bracket, or
table specified by the manufacturer, or sold with the
apparatus. When a cart is used, use caution when
moving the cart/apparatus combination to avoid
injury from tip-over.

'l @’
~——

Unplug this apparatus during lightning storms or
when unused for long periods of time.

Refer all servicing to qualified service personnel.
Servicing is required when the apparatus has been
damaged in any way, such as power-supply cord or
plug is damaged, liquid has been spilled or objects
have fallen into the apparatus, the apparatus has
been exposed to rain or moisture, does not operate
normally, or has been dropped.

Do not expose this apparatus to drips or splashes.

Do not place any objects filled with liquids, such as
vases, on the apparatus.

Do not install this apparatus in a confined space such
as a book case or similar unit.

The apparatus should be located close enough to the
AC outlet so that you can easily grasp the power cord
plug at any time.

An apparatus with Class | construction shall be
connected to an AC outlet with a protective grounding
connection.

Batteries (battery pack or batteries installed) should
not be exposed to excessive heat such as sunshine,
fire or the like.

Excessive sound pressure from earphones and head-
phones can cause hearing loss.

The apparatus draws nominal non-operating power
from the AC outlet with its STANDBY/ON in the
Standby position.
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Rack-mounting the Unit

Use the supplied rack-mounting kit to mount the unit in a

standard 19-inch rack, as shown below.
Remove the feet of the unit before mounting.

NOTE

e | eave 1U of space above the unit for ventilation.
e Allow at least 10 cm (4 in) at the rear of the unit for

ventilation.

For China
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Thank you very much for purchasing the TASCAM
US-1641 16x4 96 kHz/24 bit USB2.0 Audio/MIDI inter-
face. Please read this owner’s manual carefully before
using the unit in order to maximize your use of all its
features. We hope that you will enjoy using this product,
for many years to come.

* [f you are uncertain how to perform the basic computer
operations explained in this manual, please refer to the
owner’s manual that came with your computer.

* For information on the operation of Digital Audio
Workstation (DAW) software, please refer to the
owner’s manual for the corresponding DAW.

* TASCAM accepts no responsibility for the loss of any
data that may arise from your use or inability to use this
product to record onto MIDI equipment in your system
or onto storage devices such as hard disks.

The US-1641 is a USB-based audio interface designed for
use with Digital Audio Workstation (DAW) software, such
as Cubase LE 4. It provides abundant analog and digi-

tal inputs and outputs, and 16-channel MIDI inputs and
outputs. It is the ideal companion to any computer-based
digital recording setup.

Features

* 24-bit/96 kHz audio interface

* Analog inputs (1-14) and digital inputs (L & R) can be
used simultaneously, providing 16 audio inputs for your
computer via USB

* Eight XLR mic inputs (balanced), two line/guitar inputs
(balanced/unbalanced), and four line inputs (balanced)

* Stereo digital input jack (S/PDIF) and stereo digital
output jack (selectable between S/PDIF and AES/EBU)

* Four balanced line output, sterco monitor out, and head-
phone output

* MIDI IN/OUT

* Direct Monitor function allows zero-latency monitoring
of the input.

Supplied accessories

In addition to this manual, the following accessories are
supplied.

® USB CabIe ....ouveniiiiiiiinciieicieccnceeececcee 1
* CD-ROM (containing drivers and manuals) .............. 1
* DVD-ROM (Cubase LE 4) .....ccccooeerineiiiieceeenes 1
o Warranty card.........cooeeeeieienienieneeeee e 1

Please contact your TASCAM supplier if any of these
accessories are missing.

We recommend that you keep the original box and
packing materials for transportation of this unit.

Manual conventions

In this manual, we use the following conventions:

* Controls and keys on the US-1641 are written like this:
MENU.

* We use the term “key” to describe the push-button
controls on the US-1641.

* This typeface is used to designate on-screen controllers
or buttons: Cancel

* Except above, this typeface is used to designate any text
displayed by the software: New project

Precautions for placement and use

The US-1641 may be used in most areas, but to maintain
top performance, and prolong operating life, observe the

following notes, precautions and environmental conditions:

* Avoid exposing it to extremes of temperature and
humidity and avoid mechanical shocks and vibration.

* Keep the unit away from strong magnetic fields (TV
sets, computer monitors, large electric motors, etc.).

* The nominal temperature should be between 5°C and
35°C (41°F and 95°F).

6 TAscAm Us-1641

* Relative humidity should be 30 to 90 percent.

* As the unit may become hot during operation, always
leave sufficient space above the unit for ventilation. Do
not install this unit in a confined space such as a book-
case, and do not put anything on top of the unit.

* Avoid installing this unit on top of any heat-generating
electrical device such as a power amplifier.

* The voltage supplied to the unit should match the volt-
age as printed on the rear panel. If you are in any doubt
regarding this matter, consult an electrician.



Beware of condensation

If the unit is moved from a cold to a warm place, or used internal mechanism, making correct operation impossible.
after a sudden temperature change, there is a danger of To prevent this, or if this occurs, let the player sit for one or
condensation; vapor in the air could condense on the two hours at the new room temperature before using.

TASCAM US-1641 1



Front Panel

(1 POWER switch and indicator Turns the power to
the unit on or off. The POWER indicator lights up red
when the power is on.

(@ USB indicator Lights up green to indicate a valid
USB connection to the host computer.

(3 PHANTOM [1-4/5-8] switches Turn on the +48V
phantom power supplied to the MIC IN [1-8] jacks.

Each switch turns on the phantom power for four input
channels as a group. The phantom power is on when the
switches are pushed in.

Turn this switch on only if you are using condenser
microphones that require phantom power.

Do not connect or disconnect microphones from the
US-1641 while phantom power is on.

Never supply phantom power to unbalanced
dynamic microphones.

Some ribbon microphones can be damaged by
phantom power. If you are not sure about your
ribbon microphone, do not supply phantom power
to the ribbon microphone.

@ MIC IN [1-8] jacks These are XLR balanced analog
mic input jacks. Use the Gain knobs to adjust the input
gain level.

The wiring is as follows:
pin 1 = ground, pin 2 = hot, pin 3 = cold.

8 7ascam us-1641

(B LINE IN/GUITAR [9/10] jacks and select switches
These stereo 1/4” phone jacks function as unbalanced
guitar input jacks when the select switches are set to the
GUITAR position, and function as balanced line input
jacks when the switches are set to the LINE IN position.
(The wiring is as follows: sleeve = ground, tip = hot, ring =
cold.) Use the Gain knobs to adjust the input gain level.

® Gain knobs and indicators [1-10] Adjust the gain
level for Inputs 1-10 individually. The adjustable range

is from —2dBu to —58dBu for Mic Inputs 1-8, and from
+4dBu to -42dBu for Line Inputs 9-10. The Gain indi-
cators will light green when a signal at a certain level
(-30dBFY) or higher is present. However, if the signal level
exceeds —2dBFS, the indicators will light red.

(@ MONITOR knob Adjusts the level of signals output
from the MONITOR OUTPUTS [L/R] jacks on the rear
panel.

MIX knob Controls the balance of the signal sources
being output from the MONITOR OUTPUTS [L/R] jacks
and the PHONES jack. With this knob turned to the far
left, the US-1641 will output the signal input from the MIC
IN [1-8] jacks and LINE IN [9-14] jacks. With this knob
turned to the far right, the US-1641 will output the signal
received from the computer via USB.

(@ PHONES jack and PHONES LEVEL knob This
stereo 1/4" headphone jack outputs the same signal that is
output from the MONITOR OUTPUTS [L/R] jacks. The
PHONES LEVEL knob controls the output level of the
PHONES jack.



Rear Panel

USB connector Use a USB cable to connect this to
the host computer. (Please note that this connector supports
only USB 2.0 connection.)

@) DIGITAL IN jack This is an RCA connector that
inputs a stereo S/PDIF digital signal.

@ DIGITAL OUT jack This is an RCA connector that
outputs a stereo digital signal. Signals output from the
LINE OUT [1/2] or [3/4] jacks can be output digitally from
this jack (as set in the Control Panel). You can also select
S/PDIF or AES/EBU as the digital signal format in the
Control Panel.

@ MIDI OUT connector Transmits MIDI messages
received from the computer.

MIDI IN connector Receives MIDI messages.
The received MIDI messages will be transmitted to the
computer.

NAC)) = INPUTS
2 @ (BALANCED)

@ INPUTS [11-14] jacks and LEVEL switches These
are TRS 1/4" phone, balanced line input jacks. Use the
LEVEL switches to set the nominal level to —10dBV or
+4dBu.

You cannot adjust the gain level for these inputs.

LINE OUT [1-4] jacks These are stereo TRS 1/4"
phone, balanced line output jacks (sleeve = ground, tip =
hot, ring = cold). The nominal output level is +4dBu. These
jacks output signals received from the computer. Use DAW
software to switch between LINE OUT [1/2] and LINE
OUT [3/4].

@ MONITOR OUTPUTS [L/R] jacks These are stereo
TRS 1/4" phone, balanced output jacks (sleeve = ground,
tip = hot, ring = cold). These jacks enable you to monitor
monaural mix input (1-14) signals and/or output signals
received from the computer. Use the MONITOR knob on
the front panel to adjust the output level.

AC IN connector Connect the supplied power cable
to this connector and an AC outlet.

TASCAM US-1641 9



System requirements

Windows

Supported operating system:
32-bit Windows XP SP2 or 32-bit Windows Vista

Recommended system:

* CPU: Pentium4 or AMD Athlon 1.4 GHz or faster (or
equivalent processor)

* RAM: 512 MB or more memory

* HDD: 1 GB or more free space

* USB 2.0 port

* DVD-ROM drive to install Cubase LE 4

* Internet connection to activate Cubase LE 4

These requirements must be satisfied if you plan to use
Cubase LE 4 (bundled with the US-1641). If you are plan-
ning to use other application software, please consult

its technical documentation for operating requirements
specific to that software.

The number of available audio tracks will depend on
the speed of your hard disk. A faster hard disk will
facilitate smoother and easier operation.

USB1.1 is not supported.

TASCAM recommends that you use a system with
at least 512 MIB of memory. However, additional
memory will enhance the operation of digital audio
application software.

This product has been tested for use with typical
computers that meet the operating requirements
listed above. However, the test results do not guar-
antee that the product will operate properly with
every computer that meets these requirements.
Please be aware that even under similar conditions,
processing capabilities may vary depending on the
particular design and specifications of the computer
and the operating environment.

Mac OS X

Supported operating system:
Mac OS X version 10.4 or later

Recommended system:

* CPU: Power PC G4 1GHz or higher, Core Solo 1.5GHz
or higher

* RAM: 512 MB

* HDD: 1 GB or more free space

10 1ascam us-1641

* USB 2.0 port

* Audio device that supports Core Audio

* DVD-ROM drive to install Cubase LE 4

* Internet connection to activate Cubase LE 4

For Macintosh systems as well, additional memory and a
faster hard disk drive will facilitate smoother and easier
operation of digital audio application software.



Installing the drivers

Before you can use the US-1641, you must install the
appropriate drivers on your computer. As described below,
this is a simple process that uses the CD-ROM included
with the US-1641.

Drivers are updated from time to time. You can download
the latest version of the drivers from the TASCAM website
<http://www.tascam.com/>.

Do not connect the US-1641 to your computer before you
install the drivers.

CAUTION
Handle the enclosed CD-ROM with care. If the disc
becomes scratched or dirty, your computer may be
unable to read it and you may be unable to install
the software.

If the disc becomes unreadable, you can request a
replacement disc for a fee.

WARNING

Never attempt to play the enclosed CD-ROM in an
audio CD player. The resulting noise could damage
your speakers or your hearing.

Installing the drivers for Windows

The US-1641’s drivers are provided on the CD-ROM as an
executable installer.

You can download the latest version of the drivers from the
TASCAM website <http:/www.tascam.com/>, If the driv-
ers on the CD-ROM are not the latest version, TASCAM
recommends that you download the latest version of the
drivers from the website and install them.

Installation procedure
This section provides detailed procedures for installing the
Windows XP driver software from the included CD-ROM
and updating the firmware for the US-1641.

During installation, you must connect, discon-
nect, then reconnect the USB cable to the unit as
described in steps 7, 8, and 9.

Complete each installation step within one minute of the
display of the corresponding instruction. If you take too
much time, the installer may report an error and quit. If
this occurs, simply run the installer again.

Installing the drivers

1 Make sure that the US-1641 is not connected to your
computer via a USB cable.

2 Insert the included driver installation CD-ROM
into the CD-ROM drive on your computer.

3 Click the Install US-1641 Driver button when the
menu screen below appears.
If this screen does not appear automatically, find
and open the Autorun Menu.exe program on the
driver CD-ROM.

&= TASCAM US—1641

TASCAM ]

MAKE IT HAPPEN

Install Adobe
Acrobat (English)

Install US-1641 Driver

Install Adobe

Read Release Notes Acrobat (Japanese)

—
Go to
TASCAM website

Browse Disc

4 When the language selection screen (below) appears,
select the language you prefer, then click the OK
button.

r

£ US-1641 driver 1.00

Pleaze choogze your language below:

| Englizh

5 When the screen below appears, click the
Install the driver button.

#° US=-1641 driver 1.00

Install the driver

Remove the driver

Exit

TASCAM Us-1641 11
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3 - Installation

6 Read the contents of the License Agreement, then
select | accept the agreement if you agree to the
terms. Click the /nstall button to start installation.

& US-1641 driver 1.00 E\E|E\

License Agreement ~

IMPORTANT: PLEASE CAREFULLY READ THE LICENSE

AGREEMENT HEREIN BEFORE USIMNG THE SOFTWARE

THE RIGHT TO USE THE SOFTWARE IS GRANTED ONLY

o |OM THE CONDITION THAT vOU AGREE T0 THE LICENSE

AGREEMENT. IN CASE YOU DO NOT AGREE TO THE
LICENSE AGREEMENT. DO NOT INSTALL THE SOFTWARE
IF vOU HAVE ALREADY INSTALLED THE SOFTWARE, STOP
USING IT, AMD REMOVE THE SOFT'WARE. IF 0L DO NOT
AGREE TO THE LICEMSE AGREEMENT, YOU May RETURN
THE PACKAGE FOF A REFUND. UNAUTHORIZED
REPRODUCTION OR DISTRIBUTION OF THE SOFTWARE.
OR ANY PORTION OF IT, M&Y RESULT IN SEVERE ClvIL
AND CRIMINAL PENALTIES, AMD WILL BE PROSECUTED
TO THE M&xIMLUM EXTENT POSSIBLE UNDER Law

US-1641

O accept the agreement

(| do rot accept the agreement

7 When the screen below appears, use the supplied
USB cable to connect the US-1641 to the computer.

o0&

¢ US=1641 driver 1.00

TASCAM
US-1641

\UDIO INTERFACE

If it is not already connected. please
plug your TASCAM US-1641 to the
computer now. This might take a while.

8 When the screen below appears, unplug the connect-
ing USB cable from the US-1641 or the computer.

& US-1641 driver 1.00

TASCAM
US-1641

\UDIO INTERFACE

Please unplug your TASCAM US-1641.
then replug it to your computer.

9 When the screen below appears, reconnect the
US-1641 to the computer with the USB cable.

& US-1641 driver 1.00

TASCAM
US-1641

UDIO INTERFACE

If it is not already connected. please
plug your TASCAM US-1641 to the
computer now. This might take a while.

10 When the screen below appears, the installation is
complete. Click the Reboot now button to restart
the computer.

¢ US=1641 driver 1.00 Q\§|E\

TASCAM TASCAM.

US-1641

In order to complete the installation it is
necessary to reboot the computer.
Press <Reboot now=>. or press <Reboot
0 |ater> if you don't want to reboot now.

[Rebootnow | [ Rebootiater |

11 After the computer has restarted, select Start >
Settings > Control Panel, then click TASCAM US-
1641 Control Panel to open the US-1641 Control
Panel. If the driver version, device name and other
data appear to be correct, the installation was
successful.

Installing the drivers for Mac 0S X

1 Insert the included driver installation CD-ROM
into your computer’s DVD-ROM drive, then double-
click US-1641 Drivers.mpkg on the CD-ROM to
start the installer.

12 7ascam us-1641

2 Follow the instructions on screen.

3 Restart the computer, then use the USB cable to
connect the US-1641 to the computer.



3 - Installation

Updating the firmware for the US-1641

TASCAM may release updates for the software that runs
on the microchip inside the US-1641. This is commonly
called “firmware”. When your US-1641 is plugged into the
computer, the US-1641 Control Panel shows what firmware
version the unit is currently running. Visit TASCAM’s
website (http://www.tascam.com) to see if a newer version
of the firmware is available. If so, you can download a
firmware updater program for you computer that will
update your US-1641’s firmware.

Preparation Step 1:
Install the latest driver on your PC or Mac computer.

Preparation Step 2:
Connect the US-1641 (for which firmware will be updated)
to the computer via a USB cable.

* The firmware updater varies with the firmware version
of the unit.

For PC (Windows XP) users
1 Connect the US-1641 to the computer via a USB

cable.

2 Run the firmware updater file (for PC) for the
version to which you wish to update.
The system displays the following screen:

i US=1641 Firmware Updater 1.00

TASCAM

US-1E41 - wersion 1.00connected

| wirite Firware i

E it

3 Click the write firmware button.

4 When the update process is complete, the system
displays the following screen:

r

Update successful

IUpdate to version 1.00 successiul
Unplug the device now.

5 Disconnect the USB cable from the US-1641.
The system displays the following screen:

i US=1641 Firmware Updater 1.00

TASCAM

6 Click the Exit button to complete the update opera-
tion.

For Mac (0OS X) users

1 Connect the US-1641 to the computer via a USB
cable.

2 Run the firmware updater file (for Mac) for the
version to which you wish to update.

3 TFollow the steps for Windows PCs as described
above. The screens displayed may appear slightly
different from those shown above, but their content
is essentially the same.

TASCAM Us-1641 13



Installing Cubase LE 4

1 Insert the Cubase LE 4 DVD-ROM into the

DVD-ROM drive on your computer.

The system displays the language selection screen
(below). Select the language you prefer.

If this language screen does not appear automati-
cally, run the Setup.exe program in the \Cubase LE
4 for Windows directory on the DVD-ROM.

-

Select Laneuage

X

Fleaze select the lanzguaze that wou would like to
uze during the installation.

A
Intl. English =
Francis =
Deut=ch E
Ezpanol n
Iltal iano v

Click the /nstall button.

Cance| |

e Steinberg Cubase LE 4 Setup

<> CUBASE LE,

r The Setup Wizard is ready to begin the Installation

Click Install ko begin the Installation.

= Back. [ Install ] Cancel

The system displays the License Agreement for end
users. Read the contents, then select | accept the
terms in the License Agreement if you agree to the
terms. Click the Next button.

14 1ascam us-1641

e Steinberg Cubase LE 4 License Agreemnent

< CUBASE LE: O steinberg
r End-User License Agreement
Please read the following license agreement carefully

Steinberg
Software End User License Agreement (EULA)

(RS

General

All intellectual property rights in the software belong to Steinberg Media
Technologies GmbH (hereinafter: "Steinberg”) and its suppliers.
Steinbery permits you only to copy, download, install and use the e

()1 accept the kerms in the License Agreement

()1 do not accept the kerms in the License Agreement

[ < Back ]L ek = ] [ Cancel ]

The system displays the installation destination
screen. Browse and specify the destination for
installation, then click the Next button.

The system displays a screen indicating that it is
ready to install the application. Click the /Install
button.

Syncrosoft installer starts. Select a language for the
installation process.

The system displays the Syncrosoft Welcome screen.
Click the Next button to start the installation.

.?— Welcome

SyncrOSOft Welcome to Syncrosoft License Control Setup
I’

ypto & security solution:  Wersion 5.2.14.1

License Control For a flawless installation please follow the
instructions below

- Please connect your elicenser(s) to the USE
parts you are about to use.
- Please quit all running programs

Click <Mext= to start the installation.
Click <Cancel> to end the installation process.

Cancel




8 The system displays the License Agreement for end
users. Read the contents, then select | accept the
license agreement if you agree to the terms. Click
the Next button.

icense Agreement

syncrOSOft Enduser License Agreement (EULA)
crypto & security solutions

SOFTWARE LICENSING CONTRACT |

License Control

The following information represents
the contractual conditions for the use
of software, manufactured by 3yncrosoft
by wou, the final user.

Ev installing the software on your
computer. You are declaring yourself to
be in agreement with the contractual
conditions, so please read the
following text carefully.

If wou are not in agreement with these
conditions, you must not install the

cafrmara  Tn this avant mlaaza ratinemn

el

¥ | accept the license agreement.

< Back HMext > Cancel

9 The system displays a screen indicating that the
Syncrosoft installation is complete. Click the Finish
button to finish the installation procedure.

Installation has tinished

Syncrosoft Syncrosoft License Control has been
Crypte fsecurity seluions successfully installed.

License Control

W Show the Release Notes.

v Start License Control Center' after installation.

For more information about Syncrosoft's technologies
please visit
v, Syunciosolft. com

Ta finish the process of installation click <Finish=.

< Back I Finish I Cancel

When you start Cubase LE 4 for the first time, you
will be asked to register the software on-line. If you
do not register the software, you will be unable to
use it beyond 30 days after you install the program.
TASCAM recommends that you register the software
at your earliest convenience.
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Settings on your computer

Here are a few basic points to help you set up your computer
for best performance with audio applications.

* Do not run other applications. You will probably use
your computer for applications other than audio, but
TASCAM recommends that you avoid running other
applications at the same time you are running audio
programs. Processing digital audio places a consider-
able load on your computer. This means that if you
are running other applications (especially graphics or
Internet tools) at the same time as your audio applica-
tion, processing may not be fast enough.

16 1ascam us-1641

* Certain devices such as network cards or WinModems
can cause conflicts with USB operation. If you experi-
ence such a conflict, you can use the Device Manager to
temporarily disable the offending device.

You can also improve the audio processing capability or
increase the number of recording and playback tracks on

your computer by upgrading or expanding the computer
hardware.



Overview

The US-1641 Control Panel enables you to control various
features of the US-1641. It also reports the status of the
driver and the currently connected unit.

In Windows XP, you can access US-1641 Control Panel
shortcut from the following:

e Start menu
* Window’s Control Panel
* All Programs > TASCAM > US-1641 Control Panel

In Mac OS X, US-1641 Control Panel is located in the
Application folder. Audio MIDI settings, which is used for
audio and MIDI settings, is located in the Utility folder in
the Application folder.

The US-1641 Control Panel is divided into two sections:

Status section

This section indicates the current status of the driver and
the connected hardware. You cannot edit the settings in
this section.

Setting section

This section enables you to control various settings of the
US-1641.

Driver settings

Audio Performance (Windows PC case)

The US-1641 driver temporarily stores input and output
audio samples in buffers.

The Audio Performance setting enables you to adjust the
buffer size to five levels. The Lowest Latency setting is
the minimum buffer size, and the Highest Latency setting
is the maximum buffer size.

A smaller buffer size will reduce the audio signal delay
when you monitor the input signal, but will require your
computer to perform the processing faster. If the process-
ing does not occur in time (e.g., if the computer is perform-
ing other system operations), you may notice clicks, pops,
or dropouts in the audio signal.

A larger buffer size will provide more stable operation and
more safety against such problems caused by other system
activities, but will produce greater delay in monitoring
signals.

Select the buffer size that works best for your system.

For Mac computer users:
Mac’s control panel does not have Audio Performance on
it. Instead of Audio Performance, each DAW has audio
buffer setting which is based on sample step. That works as
the same as Audio Performance.

Sample Clock Source
You can set the clock source to Automatic or Internal.

Automatic (default): If a signal is being input to the
DIGITAL IN jack, its clock will be used. If no signal is
being input to the DIGITAL IN jack, the US-1641’s internal
clock will be used.

Internal: The US-1641’s internal clock will always be used.

Digital Output Format

This setting enables you to choose either AES/EBU or
S/PDIF as the digital output format.

Digital Output Channels

The DIGITAL OUT jack outputs signals from either Line
out 1 and 2 or Line out 3 and 4. This setting enables you
to select one of these output channel pairs.

TASCAM Us-1641 17
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USB connections

Using the included cable, connect the US-1641 to your
computer as shown in the illustration.

Some USB devices access the USB bus frequently. To
avoid dropouts and clicks in the audio signal, do not

connect other USB devices to the USB bus used by
the US-1641.

USB keyboards and mouse are exceptions to this, and
will probably not cause problems.

Audio connections

Connect the output signal of your mic, guitar, keyboard,
or other audio device to the US-1641, which will convert
the signal into digital audio and send it via USB to your
computer. Connect the output of the US-1641 to your
speakers (via an amp) or headphones, so you will be able
to monitor the audio signals coming into the US-1641 or
signals being output from your computer.

Mic
Connect your microphones to the MIC IN [1-8] jacks
(XLR). If you are using a condenser microphone that
requires phantom power, turn on the phantom power.

18 1ascam us-1641

You can use more than eight microphones by
connecting them via an external mic pre-amp. In this
case, connect the output of the mic pre-amp to the

LINE IN [11-14] jacks on the rear panel.

Guitar

Connect your electric guitar and bass guitar to the LINE
IN/GUITAR [9-10] jacks and set the GUITAR-LINE IN
switch to GUITAR.



Keyboard/drum machine/sound module/
CD player, etc. (analog connection)
Connect the analog audio output of these devices to the
LINE IN/GUITAR [9-10] jacks or INPUTS [11-14] jacks.
If you use the LINE IN/GUITAR [9-10] jacks, set the
GUITAR-LINE IN switch to LINE IN.

If you use the LINE IN/GUITAR [9-10] jacks, you can
adjust the input gain levels continuously from —6dBv

to —-52dBv. If you use the INPUTS [11-14] jacks, you
can switch the nominal level between -10dBv and
+4dBu.

Sound module/CD players, etc. (digital
connection)

Connect the digital audio output of these devices to the
DIGITAL IN jack.

The US-1641 DIGITAL OUT jack outputs either S/PDIF
or AES/EBU signals (selectable in the US-1641 Control
Panel). On the other hand, you can input S/PDIF

signals to the DIGITAL IN jack.

Headphones
Connect a set of stereo headphones to the PHONES jack
(1/4” stereo phone jack).

Powered speakers/audio system
Connect powered monitoring speakers or audio system to
the MONITOR OUTPUTS [L/R] jacks.

MIDI connections

Connect your sound module, keyboard/synthesizer, drum
machine, or other MIDI device to the US-1641 as shown in
the illustration on page 18.

The US-1641 receives MIDI signal at the MIDI IN connec-
tor, then transmits it to the connected computer. Also, the
US-1641 receives MIDI signal from the computer, then

transmits it from the MIDI OUT connector. In this way,
you can use the MIDI IN/MIDI OUT connectors to trans-
mit and receive MTC (MIDI Time Code). This allows the
MTC-compatible MTR (Multi Track Recorder) of your
DAW (Digital Audio Workstation) computer application to
synchronize with your MIDI equipment.
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6 — Recording with Cubase LE 4

This chapter explains basic operations for using the US-1641
with Cubase LE 4.

This explanation is not intended to replace the user’s manual
for Cubase LE 4. For more information on Cubase LE 4,
please refer to the Cubase LE 4 user’s manual.

Input setting

1 Start Cubase LE 4. From the Devices menu, choose
Device Setup.
The system displays the Device Setup window.

Device Setup ®
[+ - Us-1641
Devices Contral Panel Tput Latency: 7914 me
=) MIDI [~ Output Latency: 29410 ms
@ MIDI Port Setup
=) R;:::: Dcivn'fj IO Direct Monitoring
100 Video Parts Reset
o W (e 176 [Fortsystemame Show i Vete [Ste |
s Em T |US-1641 micin 1 US-1641 mic in 1 ]| Active
VST System Link I US-1641 mic in 2 US-1641 mic in 2 53] Active
I US-1641 mic in 3 US-1641 mic in 3 X Active
In US-1641 mic in 4 US-1641 mic in 4 [x] Active
In US-1841 mie in § US-1881 mic in & X Active
I |US16H micin© US-1641 mic in 6 B [Active
I US-1641 mic in 7 US-1641 mic in 7 x] Active
b |US16H micin US-1641 mic in & [ Active
I US-1641 instrument in 9 US-1641 inetrument in 9 x] Active
I | US-1641 instrument in 10 US-1841 instrument n 10| [X] | Active
I US-1641 line in 11 US-1641 line in 11 53] Active
I US-1641 line in 12 US-1641 line in 12 X Active
In US-1641 line in 13 US-1641 line in 13 [x] Active
In US-1641 line in 14 US-1841 line in 14 X Active
| US-1641 dieital in left US-1641 digital in Ieft B [Active
I Us-1641 digital in right US-1641 digital in right x] Active
Out_| US1641 aut 1 US-1641 out 1 %[ Active
Out | US-1641 out 2 US-1641 out 2 [x] | Active
| [ou (05164 out 8 U5-1641 out 3 (]| astive [}
- e

2 In the VST Audio System section in the right side of
the Device Setup window, select US1641 for ASIO
Driver.

3 From the Devices menu, choose VST Connection.
The system displays the VST Connections window,
which features two tabs: Input and Output.

4 Select the Inputs tab, then set the input bus.

. VST Connections — Inputs

Inputs 1 Cutputs ]
EE Al AddBus | Frecets | RN -]
Eus hlame | speakers | Audic Device | Deviee Port
El--ft Mono I | Mono Us-1641

fe—0 Mono US-1641 mic in 3
E- Mona In 2 Mana L5164

fn =0 Mang US-T641 mic in 4
- Mana In 3 Moo US-1641

o Mano US-1641 mic in &
El--Moro n 4 Mana Us-1641

fe—0 Mono US-1641 mic in &
E- Maona In B Mana L5164

fn =0 Mang US-1641 mic in 7
El--Moro b 6 Mana Us-1641

fe—0 Mono US-1641 mic in 8
E- Maona In 7 Mana L5164

om0 Mono US-1641 instrument in 9
- Mana In 8 Moo US-1641

© o Mono LE-1641 instrument in 10
El--Moro b 8 Mana Us-1641

fe—0 Mono US-1641 line in 11
H-MonaIn 10 | Mano L5164

fn =0 Mang US-T641 line in 12
FESI TR ST Ll LS=1547

When you set the input bus, a device port is auto-
matically selected. If necessary, you can change the
device port. The device port pull-down list indicates
all available input ports for the US-1641.
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5 Select the Outputs tab, then set the output bus.

V5T Gonnections — Outputs

Inputs 1 Oulputsl

EEAl  AddBus | Presets | -
Eus hame | Speakers | Audic Device | Davies Port | Gick.
- e Stereo Out Stereo Us-1641 Glick.
=0 Left US-1641 out 1
o Right US-1641 out 2
El-- Mana Qut Mana Us-1641
fee—0 Mono US-1641 out 3
=l Mana Out 2 Mano Us-1641
i =0 Mono US-1641 out 4

When you set the output bus, a device port is auto-
matically selected. If necessary, you can change the
device port. The device port pull-down list indicates
all available output ports for the US-1641.

6 From the File menu, choose New Project.

- Hew Project E|

Templates:
EvaBase

GLE4 - 16 MIDI Tracks

CLE4 - 4 Stereo 8 Mono Audio Track Recorder
GLE4 - Cubase Synths On hstrument Tracks
CLE4 - Mastering Setup

CLE4 - Podeasting

default

-

[ OK H Gancel ]

The system displays a window that enables you to
select a template for your new project. Select the
desired template and press the OK button. The
system displays the Select directly window. Specify
the directory in which you wish to save the project,
then click the OK button. The new project will be
created.

If you have selected an Empty template, add audio
tracks to the project by selecting Add Tracks from
the Project menu.

You are now ready to begin recording.



6 — Recording with Cubase LE 4

Recording

1

Click the Edit Channel Settings button for the track
you want to record to open the Channel Setting
window. Then, specify the desired input bus in the
Input field located in the upper-right corner.

VST Audio Channy

2 Click the REC FUNCTION button to turn it on (the

button indicator will light).

. Gubase LE 4 Project — Untitledil

g8 Pl O] > [ e JiN

Press the (REC) button in the transport section
to start recording.

CLICKEY OFF
TEMED Fl=ED

= | Metronome/Cl
o] O D

SYHC IMT.

When you finish recording, press the [ O | (STOP)
button, then click the REC FUNCTION button to
turn it off (the button indicator will turn off).
Rewind if necessary.

Repeat steps 1, 2, and 3 to overdub additional
tracks.

TASCAM Us-1641 21



Mixdown

1 Move the left and right locators to specify the region
that you want to mix down.

MENNOE RS BI | =

' ' ' '
1 s ] 13

2 From the File menu, choose Export > Audio
Mixdown.

Cubase LE 4

fudio MIDI  Media  Transport  Devices  Window

Mew Project Ctrl+MN

Open... Ctrl+0

Cloze Crh+iy

Save Oirks | > [ e Jin Y
Save fs.. Ctri+Shift+3

Save Project to Mew Folder..
Save az Template..
EBevert

Page Setup..
Frint...

Impo

Preferences..
Kev Commands...

Fecent Projects 3

it Ctrl+Q
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3 In the Export Audio Mixdown dialog box, make the
desired settings, then press the £Export button.

Export Audio Mixdown

~ File Location

File Mame longingfory:

Uze Project Audio Folder Chooze
— File Format

Wave File

MW Ihzert Broadcast Wave Chunk Edit

— fudio Engine Output

Update Dizplay

M Split Ghannels Bit Depth

— Import into project

Paal Audio Track

M Ciloze dialoe after expart Cloze ] [ Export ]




This chapter answers frequently asked questions related to
recording with Cubase LE 4.

Q1. I think | have configured the input settings
properly, but | see no activity on the audio
track's meter.

A1. Make sure that the Monitor button of the track is
enabled.

@E] Audio 01

®® Rl e
steren [—D—I-(I}I-IE][DB]

Q2. | would like to record two channels simul-
taneously in stereo.

A2. Before you record, choose Stereo track(s) or add
Audio track(s) as Stereo. In this case, the track input is
indicated as Stereo in or something similar.

Q3. 1 am trying to use the EQ, but it does not
seem to do anything.

A3. Check the VST channel setting or other settings to
make sure that EQ bypass is disabled.

| (m ] S]msT ®® ©
stereo

[EGiz State (Bvpass EQs with click)

Q4. | tried to mix down a three-minute song,
but could mix only ten seconds.

AA4. Make sure that the region specified by the left and
right locators is set to three minutes or longer.

Q5. | cannot set the locator region to more
than ten minutes.

AD5. The default setting is ten minutes. From the Project
menu, choose Project Setup and then change the Length
field.

Project Setup

|:||:u:|;|:u:|,|:u :

7 - Troubleshooting

Q6. | burned a CD using the WAV file | mixed
down, but the speed is obviously different.
A6. Could the sampling rate of your project be set to

48 kHz? If your ultimate objective is to create a CD,
TASCAM recommends that the sampling rate be set to
44.1 kHz from the beginning.

To specify the sampling rate, choose Project Settings
from the Project menu, then set the sampling rate to
44100 kHz.

"~ Project Setup @

el alilele] | epeth

~| Frame Rate

Earz+Beats

-| Dizplay Format

m Dizplay Offzet

4.1 00 kHz

| » 44100 kHz cord Format
48.000 kHz
| 23200 kHz cord File Tvpe
26,000 kHz tereo Pan Law
l Help ] I OF ] l Cancel ]

Q7. | have connected an audio source to the
US-1641, but cannot hear anything.

A7. Make sure that the input level is raised appropriately.
When a signal is being input, the Gain indicator will light
up green. Make sure that the monitor (or headphone) level
is raised, and that the connections are correct.

Q8. The sound is distorted.

AB8. Make sure that the signal is not overloading. If the
signal is analog, the ideal level is when the Gain indicator
lights up red occasionally.

Q9. | tried to change the sample rate in the
Control Panel, but could not.

A9. If a valid signal is plugged into the US-1641’s digital
input, and the Sample Clock Source menu has been set to
Automatic, the US-1641 will always run at the sample rate
received at its digital input. To run at a different sample
rate while continuing to receive digital audio, you must
change the sample rate of the device that is sending the
digital signal. If you do not need to continue to receive
digital audio, you can set the Sample Clock Source menu
to Internal or simply unplug the cable connected to the
digital input.
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8 - Specifications

Inputs and outputs

MIC IN [1-8] jacks (analog)

Connector XLR-3-31

Type and wiring Balanced (1: ground, 2: hot, 3: cold)
Input impedance 2.2kQ)

Input level (with the Gain knobs set at maximum) -58dBu

Input level (with the Gain knobs set at minimum) -2dBu

Headroom 16dB

LINE IN/GUITAR [9-10] jacks (analog)

Connector 1/4” phone jack

[With the LINE IN-GUITAR switch set to LINE IN]

Type and wiring Balanced (Tip: hot, Ring: cold, Sleeve: ground)

Input impedance 10kQ2

Nominal input level (with the Gain knobs set at maximum) -42dBu

Nominal input level (with the Gain knobs set at minimum)  +4dBu

Headroom 16dB

[With the LINE IN-GUITAR switch set to GUITAR]

Type Unbalanced

Input impedance 700kQ2

Nominal input level (with the Gain knobs set at maximum) -52dBv

Nominal input level (with the Gain knobs set at minimum) -6dBv

Headroom 6dB
INPUTS [11-14] jacks (analog)

Connector 1/4” phone jack
Type and wiring Balanced (Tip: hot, Ring: cold, Sleeve: ground)
Input impedance 10kQ

Nominal input level (selectable with the LEVEL switch) +4dBu or -10dBv

Headroom 16dB
DIGITAL IN jack (digital)

Connector RCA pin jack
Signal format IEC60958 Consumer (S/PDIF)
Level 0.5Vpp/75Q2
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8 - Specifications

DIGITAL OUT jack (digital)
Connector RCA pin jack
Signal format Selectable in the Control Panel between IEC60958 Consumer
(S/PDIF) and IEC958 Professional (AES/EBU)
Level 0.5Vpp/75Q2
LINE OUT [1-4] jacks (analog)
Connector 1/4” phone jack
Type and wiring Balanced (Tip: hot, Ring: cold, Sleeve: ground)
Output impedance 100Q2
Nominal output level +4dBu
Maximum output level +20dBu
MONITOR OUTPUTS [L/R] jacks (analog)
Connector 1/4” phone jack
Type and wiring Balanced (Tip: hot, Ring: cold, Sleeve: ground)
Output impedance 100Q2
Nominal output level +4dBu
Maximum output level +24dBu
PHONES jack (analog)
Connector 1/4” stereo phone jack (Tip: L, Ring: R, Sleeve: ground)
Maximum output level 50mW + 50mW (32€2/1% distortion)
MIDI IN connector
Connector 5-pin Din [Standard MIDI format]
MIDI OUT connector
Connector 5-pin Din [Standard MIDI format]
USB connector
Connector USB Series B connector
Format USB 2.0
General specifications
Sampling rate (internal clock) 44 1kHz, 48kHz, 88.2kHz, 96kHz
Sample width 24-bit
External dimensions (W x D x H) 482.6 x 280 x 44 (mm) /19 x 11.1 x 1.74 (in)
Weight 3.2kg/ 71Ib
Power U.S.A./Canada 120V AC, 60Hz
U.K./Europe 230V AC, 50Hz
Australia 240V AC, 50Hz
Power consumption 10W
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8 - Specifications

Audio performance

Delay

<0.63ms (ADC), <0.44ms (DAC) (at Fs 44.1kHz)
<0.29ms (ADC), <0.20ms (DAC) (at Fs 96kHz)

Signal-to-noise ratio

[With MIX knob set to COMPUTER]

MIC IN [1-8] -> LINE OUT [1-4] <-60dBu (with Gain knob set to maximum)
LINE IN [9-10] -> LINE OUT [1-4] <-55dBu (with Gain knob set to maximum)
INPUTS (11-14) -> MONITOR OUT (L/R) <-70dBu (with MONITOR knob set to maximum)

[With MIX knob set to INPUT]

Allinputs -> MONITOR OUT (L/R) <-60dBu (with Gain knobs and MONITOR knob set to maximum)
Frequency response (LINE OUT, —-10dBV)
Normal sampling rate 20Hz - 20kHz, +1/-1dB

High sampling rate 20Hz - 40kHz, +1/-3dB
Total harmonic distortion (20Hz - 20kHz)

<0.01% (All outputs, minimum gain, maximum input level, excluding GUITAR IN)
Crosstalk (1kHz)

90dB

Host computer compatibility

Operating system

Windows 32-bit Windows XP SP2 or 32-bit Windows Vista

Macintosh Mac OS X version 10.4 or later
Drivers

WDM (KS), ASIO/ASIO2 and GSIF2 interface (Windows XP, Windows Vista)
Core Audio and MIDI interface (Macintosh OS X)

* Microsoft, Windows, Windows XP, and Windows Vista are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

* Macintosh, Mac OS and Mac OS X are trademarks of Apple Inc., registered in the U.S. and other countries.
* AMD Athlon is a trademark of Advanced Micro Devices, Inc.
* Pentium is a trademark of Intel Corporation in the U.S. and other countries.

* The name of companies and products described in this manual are trademarks or registered trademarks of the correspond-
ing owners.
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Dimensions

432.6 mm
= | =
£
o
g
(©)
— ST Dwo m m
434.2 mm
482.6 mm

1.4 mm

44.0 mm

0.5 mm

1.0 mm

TASCAM Us-1641 27 I



TASCAM

TEAC PROFESSIONAL

US-1641

TEAC CORPORATION www.tascam.jp
Phone: +81-42-356-9143
1-47 Ochiai, Tama-shi, Tokyo 206-8530, Japan

TEAC AMERICA, INC. www.tascam.com
Phone: +1-323-726-0303
7733 Telegraph Road, Montebello, California 90640, USA

TEAC CANADA LTD. www.tascam.com
Phone: +1905-890-8008 Facsimile: +1905-890-9888
5939 Wallace Street, Mississauga, Ontario L4Z 178, Canada

TEAC MEXICO, S.A. De CV www.teacmexico.net
Phone: +52-55-5010-6000
Rio Churubusco 364, Colonia Del Carmen, Delegacién Coyoacan, CP 04100, México DF, México

TEAC UK LIMITED www.tascam.co.uk
Phone: +44-8451-302511
Suites 19 & 20, Building 6, Croxley Green Business Park, Hatters Lane, Watford, Hertfordshire, WD18 8TE, UK

TEAC EUROPE GmbH www.tascam.de
Phone: +49-611-71580
Bahnstrasse 12, 65205 Wiesbaden-Erbenheim, Germany

Printed in China



	IMPORTANT SAFETY PRECAUTIONS
	Safety Information
	Contents
	1 - Introduction
	Features
	Supplied accessories
	Manual conventions
	Precautions for placement and use
	Beware of condensation


	2 - Parts of the US-1641
	Front Panel
	Rear Panel

	3 - Installation
	System requirements
	Windows
	Mac OS X

	Installing the drivers
	Installing the drivers for Windows
	Installing the drivers for Mac OS X
	Updating the firmware for the US-1641

	Installing Cubase LE4
	Settings on your computer

	4 - Control Panel settings
	Overview
	Driver settings
	Audio Performance (Windows PC case) 
	Sample Clock Source
	Digital Output Format
	Digital Output Channels


	5 - Connections
	USB connections
	Audio connections
	Mic 
	Guitar 
	Keyboard/drum machine/sound module/CD player, etc. (analog connection) 
	Sound module/CD players, etc. (digital connection) 
	Headphones 
	Powered speakers/audio system 

	MIDI connections

	6 - Recording with Cubase LE4
	Input setting
	Recording
	Mixdown

	7 - Troubleshooting
	8 - Specifications
	Inputs and outputs 
	General specifications 
	Audio performance 
	Host computer compatibility 
	Dimensions


